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INSTALLING OR OTHERWISE USING OR COPYING THE SOFTWARE YOU INDICATE THAT YOU AGREE TO BE

BOUND BY ALL THE Tl DO NOT AGREE TO THE TERMS OF THIS LICENSE, NXP
IS UNWILLING TO LIC e D NOT DOWNLOAD, INSTALL, USE, OR COPY THE
scmwapz’ DUwD -

RIRSIND—EBLN MNPCXpresso_ 822 650exe] DUIDED )DL TA YA L—2&SFD>V0O
—RUTLIZEN, DUy DIBRBESDYO—RHMBEDET, T71ILDOT 1 IHIERBICKELNZH.
Ay 0O— RICEEHIHHODIZENHNDFEFINDT., TERELIZE),

Software & Support
Product Download
Product List
Froduct Search LPCXpresso IDE for Windows v8.x.x
Order History
Recent Product Releases J Files | License Keys  Notes @Download Hel
Recent Updates
Licensing Once downloaded and installed, you can activate LPCXpresso IDE (Free Edition) or purchase
License Lists LPCXpresso IDE (Pro Edition) directly from the NXP LPCXpresso IDE webstore and then activate
Offiine Activation LPCXpresso IDE (Pro Edition).
FAQ For more information and assistance, please see the LPCXpresso IDE Installation and Licensing Guide

included within the product installation or visit the LPCXpresso IDE Forums and FAQs.
Downlead Help

Table of Contents

FAQs Show All Files E 9 IJ v 9

[] + File Description ¥ FileSize ¥ File MNa =
o + Installer: LPCXpresso vB8.2.2 for Windows 4456 6 ME' 4 LPCxpresso_8.2.2_650_exe
o + Installer: LPCXpresso vB8.2.0 for Windows 4374 MB ¥ LPC¥presso_8.2.0_647 exe
o + Installer: LPCXpresso vB.1.4 Windows 438.2 MB ¥ LPC¥presso_8.1.4 606 exe
O + Installer: LPCXpressc v8.1.2 Windows 4382 MB & LPC¥presso_8.1.2_603.exe
O + Installer: LPCXpressc 8.1.0 Windows 4375 MB & LPC¥presso_8.1.0_597 exs
O + Installer: LPCXpressc ,8.0.0 Windows 4278 MB & LPCXpresso_8.0.0_526.exe

Download Selected Files
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6-2 LPCXpresso D1~V L—=)b

> 0— R U LPCXpresso Z PC [C1 VA~ —)LF DIFAIC DN TERBELE T,
SFOVO—-FURAYRE=3 (exe 77 1)L) ZFRTU. UMTROFIRISOE>TA YA —I)LEEDFT,
T A VR E=IVPICRY FDO—=DICERIDCENDDFT, ZORIF. R FDO—DBGEHFI U THE
EaEDHTIZE0N,

¥Windows D/N—=I 3 VICK DT, IENEFTERDHZSHHDET,

E LPCXpresso_Setup_v8.2.2

B3 Setup - LPCpresso — *

FEEEEADMEITIL: NXP Semiconductors USA. Inc.
TP AFE: Z0AYE1-7-EQN-F R34

(V&I T

Welcome to the LPCXpresso
Setup Wizard

This will install LPCXpresso 8.2.2 [Build 650] on your computer,

&R

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

LPCXPRESSO

N

B3 Setup - LPCXpresso — *
License Agreement
Please read the following important information before continuing.
POOTESD

FPlease read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

NXP SEMICONDUCTORS USA, INC. ~ N EXT E# g-

End-User License Agreement for LPCXpresso Software Development
Tools

http:/fwww.nxp.com esso Next > || o

(Rer. 2015-06-30)

THIS END US]] LEGAL
AG \ UAL. OR
L= TTLTMA §I‘JD§—5 E'I)Ei\ ThT v
B3 Setup - LPCXpresso -
@1 acoept the agreement - B3 Setup - LPCXpre: >
(01 do not accept the agreement - Information 'a
v8.2,2_650 Please read the following important information before continuing.
http: fwiw. nxp. com/lpcxpresso | <Back [ Mext> | | cancel | Lo
/ When you are ready to continue with Setup, dick Mext.

NEXT E}$§- _/ Welcome to LPCXpresso A

LPCXpresso provides a complete Rapid Embedded Development environment for
MNXP LPC Microcontrollers.

LPCXpresso consists of the following components:

- LPCXPresso IDE, an Edipse-based Integrated Development Environment (IDE)

- LPCXpresso utilities, plugins, examples and documentation

- GMU-based C/C++ compilation tools and documentation

- Command line utilites.

LPCXpresso runs on Microsoft Windows platforms (XP SP3 and later), both 32-bit
and 64-bit, many Linux distributions induding Ubuntu and Fedora, and Mac OS5 X

(Lion or later)
IF(IJIrun]J-based support‘an be Four:lrd by visiting ]
v8.2,2_650
http: {fwww.nxp.com 550 | P || Next> | | Cancel

NEXT Z#89 —/
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B3 Setup - LPCXpresso —

Select Destination Location
Where should LPCXpresso be installed?

X

Setup will install LPCXpresso into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

C:¥nxp¥LPCXpresso_8.2.2_650 | | Bromse...

Atleast 1,008.8 MB of free disk space is required.
¥8.2.2 650

hittp:/fwww.nxp. com 2550 | < Back || Next = || Cancel

_/

NEXT Z#9

B3 Setup - LPCXpresso —

Debug driver selection
Please select which drivers to install,

X

Windows may issue warnings when instaling these drivers.
If prompted, please allow the drivers to install.
Drivers are located in the "Drivers” directory of the installation

NXP LPC-Link1 Debug drivers
Red Probe Debug drivers

Folder Does Mot Exist

The folder:
C:¥nxp¥LPCXpresso_8.2.2_650

does not exist. Would you like the folder to be created?

B

/

DDA

EAk=E)

Ed Setup - LPCXpresso —

Select Start Menu Folder
Where should Setup place the program's shortcuts?

X

Setup will create the program's shortcuts in the following Start Menu folder.

—

then dick Next.

Additional icons:
Create a desktop icon

- (@ For all users

----- (O For current user only

8.2.2_FE0

Select the additional tasks you would like Setup to perform while installing LPCXpresso,

Vi'2'2_650 To continue, dick Next. If you would like to select a different folder, dick Browse.,

H WW.N. .Com, 2550 Cancel

LN N;xt > || [LPexpressa va.2.2_650 | | Browse...
NEXT Z#39 -

B3 Setup - LPCHpresso — X

Select Additional Tasks 'i AL

nal 1 asl
Which additional tasks should be performed? !. hittp:/ fuww.nxp. com/lpcipressa | <Back [ MNext> | | cancel
WPOESSD

NEXT &#%9

http:/fwww.nxp.com B850 |

<Back [ Next> | | cancel

NEXT Z#9
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Ready to Install
Setup is now ready to begin installing LPCXpresso on your computer.

i -

Click Install to continue with the installation, or dick Back if you want to review or

change any settings.

Destination location: ~
C:¥nup¥LPC¥presso_8.2.2_650
Start Menu folder: E3 Setup - LPCXp - s
LPCXpresso v8.2.2_650 )
Additional tasks: Installing _ 'a
Additional icons: Flease wait while Setup installs LPCXpresso on your computer,
Create a desktop icon PEGHESED
For all users
Instal drivers: Extracting files...
s I\Dﬂi’rll‘;gj_linkl Debug drivers w C:¥,, ¥Drivers¥ipc18ux_43xx_winush_drivers_v 1.00¥amds4¥WdfColnstaller01009.dl
¥E.2,2_650
httpe/fwww. nxp. com 880 | < Back |I Instal | | c
y 2
—/ [—] 4
Install 289 STITETHD
v8.2,2_650
BEw =UbS % http: /fwww.nxp.com 2580
ZOF IR VIR TEAY AN WLETH?
£&70: Philips (NXP) 1Z/(-# )L YY) K2 IV bO-5-
<9 3{77: NXP Semiconductors USA. Inc.
“NXP Semiconductors USA. Inc." #'50Y 7~II7E | avab-mn | [ AvAILEDeN |
EIEFEIA)
3 VvE.2 *

© EEIIRTTNSORSA/ - YINITFOHEAVA-ILTGE .
b3

1 IVAR—)VERT

Continuing to install drivers

B3 Setup - LPCX

Information
Please read the following important information before continuing.

Check that System Protection is enabled

o Failed to create System Restore Point for LPCKpresso before installing
drivers,

OK &g

When you are ready to continue with Setup, dick Mext.

LPCXpresso IDE 8

== Supported Hosts ==

* Following the discontinuation of support by Microsoft, Windows XP
is no longer an offidally supported platform. LPCXpresso IDE may
continue to work on Windows ¥P, but this can no longer be
guaranteed, LPCXpresso is no longer tested on Windows XP,

*Mac 05 X 10.7 (Lion) is no longer an offidally supported

this can no longer be guaranteed. LPC¥presso is no longer tested
on Mac 05 X 10,7,

== Known Issues ==
*Restart workaround on Mac 05 ¥ (due to an issue with GDE)
may leave an unknown “thread” in the debug view - hit Terminate

platform. LPCXpresso IDE may continue to work on Mac OS5 X 10.7, but

B3 Setup - LPCX

Wizard

icons.

¥8,2,2_650

hittpe ffwww.nxp. com £380

Mext =

NEXT Z#9

LPCXPRESSO

X

Click Finish to exit Setup.

Completing the LPCXpresso Setup

Setup has finished installing LPCXpresso on your computer.,
The application may be launched by selecting the installed

Launch LPCXpresso v8.2
Display LPCXpresso v8. 2 Documentation
LPCYpresso IDE User Guide (PDF)

http: /fwww.nxp.com 2550

| <Bak [ Finsh |
J

Finish &89 &. LPCXpresso hWe#d D

M ET. LPCXpresso D1 VA L—)UIEZTTY, L\ TRIBET:RBET D
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6-3 LPCXpresso MicE)& sREE

RIC, LFOFIEICTE T SWEHFRZITNE T, seFECTIEA YA E—)LURE PC Z+1 V5 —Ry ~TE:
I d. FEE 1YY=y FCE#HL TS PCOMEICZDBHDET,

@ FF, LPCXpresso Zi& LF T, &I DICIE. TRO YT EOPAIVETTIVD ) v DI DD\

A=A Za—DINTDOTOTSAKD TLPCXpresso v82.21 > MLPCXpresso v822] &7
w2 UTLIEE0),

@ BIFIDEUTOBENRRISNET,

LPCXpresso (Free Edition)

X3

LPCXPRESSO

LPCXpresso v8.2.2 [Build 650] [2016-09-09
(c) 2013-2016 NXP Semiconductors, BV. AII nghts reserved

v

@ WAZTOTCVVBENEUTDRIBERTINEINEIDT, OK 2B LIE T,

X

X
LPCXpresso 4 h
LPCXpresso

License type: UNREGISTERED (Code=1)
Debug limit: 8k
Activation code: not available

To activate a license, please select
Help->Activate LPCXPresso (Free Edition)

License Restriction:

An UNREGISTERED copy of LPCXpresso (Free Edition) may only be used for evaluation purposes.
Some features have been disabled and so your product may not work as expected
Register and activate to remove these restrictions.

OK &89
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@ HEEFIDE. UNOREBEARTZSNET,

4 Develop - Welcome page - LPCXpresso

File Edit Navigate Search

irﬁ'm..“m;l SERAA ]

Project Run Window Help

[y Project Ex... 23

FrO0-Q el mdpme-lE iSSP A ™ P

@ Welcome 3

s+ Uil Registers &1 Symbol V =g

X

s | |

L
Blg v @ < [files///C/nxp/LPCXpresso_8.2.2_650/Ipcxpressofpages/unregi ition.htm e B
W &
W ——
Please note: Your product is not activated.
A product that has not been activated may only be used for Evaluation purposes.
Code size is limited to 8KB and features have been disabled, so your product may not work as expected. Register and
activate your product to remove these restrictions.
Activating LPCXpresso IDE (Free Edition)
Note: You will need to have created an account and logged on to the LPCware website to be able to obtain an acfivation
code.
; %)= Variabl.. Oa B2 Outline =
O Quicks... & (= Variabl.. % utline = To activate your product from LPCXpresso IDE
1. Help->Activate->Create Serial number and register (Free Edition)...
4 Start here & # Your product's serial number wiill be displayed
Import project(s) » Write down the serial number or copy it into the clipboard
& Import project(s 2. Press OK, and a web browser will be opened on the Activations page.
€] New project... # If you are already logged in to the website, the serial number will be completed for you.
B Build all projects [] # If you are not logged in, you will need to login, navigate to the My Registrations page, and enter the product's serial
o
number.
w v
&, Build " ] 3. Complete the rest of the form and press the button to request the activation code.
Clean "] " > = " T =
4 B Console 52 [£] Problems [J Memory @ Instruct e ent Too #BEB8-2vr=08
b un

B Y—IUIN—DANILTH5. Help>Activate >Create serial number and register (Free Edition) ZB8 =

EXR

relop - Welcome page - LPCXpresso

Edit Navigate Search Project Run Window @ Help

(@ Help Contents

= LPCXpresso IDE User Guide
gjecs %’ Search
Dynamic Help
Key Assist...
Tips and Tricks...
Cheat Sheets...

Install New Software...
Installation Details

@

®

Q  Display license type
$4  Product Information
¥4 Support

Ctrl+Shift+L

TENpE=ls ISP IS
= B8 |@ Welcome 23.
g -

B [file///C/nxp/LPCKpresso_8.2.2 650/1

N

Please note: Your
A product that has not b

Code size is limited to 8KB and featt

activate your product to remove the!

Activating LPCXpresso W E:ﬁ <

> B4 Purchase from LPCXpresso Webstore have crea
54 About LPCXpresso Free
| eate serial nu on)... bict from LP
icks... 9 Break.. D Outiine 6¢'E i it
sicl 2 'o Brea ; % B4 Activate (Free Edition L create s
-- Pro Edition -- s serial nur
Bhae 34 Activate (Pro Edition)... e serial nu
. i iti web brow!
T o Deactivate (Pro Edition)... :
E R Password reminder (Pro Edition)... ady loggec
lew project... S i . logged in,
) mySoftwareLicense web portal (Pro Edition)...
uild all projects [1

® RIMSNEYIPILTIYN=ZAE, JE-FIRELT. —BHICREFELTHRE. OK 2B LET,

X

X

Create serial number and register (Free Edition)...

Av]

Select OK to visit the registration website where you ca
register your product and receive an Activation Cod

JUPIWFIN—ZXELTRL

¥

Serial number

Rk o R S S S S o S S o S o o S SR S R R R R S e S |

[ Open in external browser

Copy Serial Number to clipboard

FIvDID

ok || Cancel |

OK Z#8d
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@ OKZ®I &, UTFOOT+ YBENBEEET, 1 YRAF—3&5DY0—- R UEKRICERULCPADY

FOd—Y—-8. NRDO—FZ2ABDL. OTJ1YULET,

(OT74 VEHDEBEE. ODEELRESEIDOT, @ GRIRELET.)

@ sign In or Register

Software Center

Signin

(SRUEA-ILP H/Z’é?\b

“"N-‘ux -"'"‘k'ku«uuu

Email Address — [— q —
ERUIC/INRD—RZAD

Password

Why register?

Remember me ®

Get easy access to all your embedded design needs when you register on nxp.com:

Download software and tools

Forgot yotwpasswor|
2 ; ) 9 |J “J 9 Order product samples

OJ4 VhH5% T LIZ5. My Activations D/R—I DRI SINDD T Activate =0 w I LT ZE0),

N
“ A

@ LPCXpresso IDE Free Edition Activations

DUy
Activate My Activations
My Activations
Serial No LP

© Serial Number . MIEBIC. LEEXTEULEIYUPILTYIN=EAD L.
VED ) UTLIEE0N,

@& LPCXpresso IDE Free Edition Activations

Activate My Activations

LPCXpresso IDE Free Edition Activation

Instructions:

1) Enter your LPCXpresso IDE serial number, as created by the IDE menu
Help = Activate -> Create Serial Number

2) Click on Register LPCXpresso

lRegister LPCXpressol h4

3) Copy your generated LPCXpresso IDE Free Edition activation code and paste it into the IDE menu:

Help -= Activate -> Activate (Free Edition) | J

PIVFIN-ZANT D

EE RO S S L S R S L S R o

Serial Number :

Register LPCXpresso Z#9
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MY VEBIT E, MUIFDKSIC Mactivation codel NERIRSNFEIT DT, XEZWM> TSN, XE
EEBEIICR=IYERBE U TCUE2EZBER. NXP XUN=R=I[COT1V L. BFaP - PTUT—
3 >®M My LPCXpresso activations] &2 w2 LT ZE), My Activations] 7 ZZIRL
TL\ErE< & TLPCXpresso Activation Key ] DEsR CEE I,

NXP OJ 1 NX—=3 | https'//www.nxp.com/security/login

@ LPCXpresso IDE Free Edition Activations

Activate My Activations

LPCXpresso Activation Key Generated

Serial Number
EE S L L L D I SR U S L D L S UL L S D S L S S S D

Activation code ZXE L THRL
LPCXpresso Activation Key

Fhkhokkhkbokhdh kb hbokhdhohkhb okhkhokdkhk

A LPCXpresso DY —J)U/\—H'5 Help > Activate > Activate(Free Edition) Z&IR L T2\,

Ef Develop - Welcome page - LPCXpresso

File Edit Mavigate Search Project Run Window Help

B (7) Help Contents Y ® EAL AT S )
LPCXpresso User Guide

i Search

ﬁ}‘_jPrQ\.H b Dynamic Help Welcome 3
= | files, .

Koy Assist.. E— B o | files//C/nxp/LPCXpressc_7.8.2_493/Ipcxpressofpages/
Tips and Tricks...
Cheat Sheets... “ '

[k Install New Software... ‘ k

B Installation Details

0 Bt lease note: Your product is not acti

K Product Information product that has not been activated may only t

7 et IX] T prot E:a <

Activate 4 Purchase from LPCXpresso Webstore
About LPCXpresso -- Free Edition --

Create serial number and register (Free Edition)... e Lp
e
Activate (Free Edition)...

da. 5 = g -- Pro Edition --

| Ed Start here
# Imoort oroiect(s)

[ Activate (Pro Edition)... it

~ € Deactivate (Pro Edition)...

»

=

Passward reminder (Pro Edition)...

@ ADBHRTISINDDT. WOTRRSINIE lactivation code] ZEAHNLTOK B LET,
%

Activate (Free Edition)... -
Activation code ZANT D

Activate your product by entering your Activation Céde

Activation code || Fhkkokkkkokk ko kkdkkokkdok ok kk kR ko kkkk ok Rk o kdokk I

OK &9
Gance
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https://www.nxp.com/security/login

@ FINERICTTIDE. UMFDOXDICRIIN, FIRDERFSNE T, OK 2B LI T,
X

Activate (Free Edition)... 0
LPCXpresso =3

License type: FULL
Debug limit: 256k
Activation code: IULR-BTJW-M4KU-E2MX-FVLX-HYF4-HOGV-DYCS

A FULL copy of LPCXpresso (Free Edition) may be used for production.

QK

OK zid

POF4RN=Y3INRTIBE. LPCXpresso ZBRENTDEDMNY TP v ITHHEFIDT Yes &
RUTCBBELTZEE),

kd Activate (Free Edition)...

% LPCXpresso must be restarted. Restart Now?

Yes &89

M ET, LPCXpresso DREHFEII5T T TI,
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6-4 BYIJILTOY DDA YR—-LEEILE

WKWK CEBYYITINTOTSAZEFHHAH. CPUNEZAHET, CCCTERIDTYTIILITOTS
LI BEEREETOLCRREDTOIY D FEMTY Y IV ERH L TNEIDT. MUY IILTOYT I ]
EWUVFET, MFOFIBICE>T,. UYTILTOI D DA UR—~EEILREZET >TSS,

(1)D=DIAR=D # VI DEE

LPCXpresso &1 VR ~—)LURKIC, MTFOBMICREDT —DAR-MESNET, COEE, 1
—Y-BCEAXT (BAEBRL) H'EENDIHE. ERICENRTEFZLADT, D-DUZR-2T 7/l
SFDEEZTTO TS,

* WindowsXP D&
C¥Documents and Settings¥[1 — 5 —& %]¥My Documents¥L PCXpresso_8.2.2_650¥workspace

* Windows Vista/7/8/8.1/10 D&
C¥Users¥[1—t—&%]1¥Documents¥ LPCXpresso_8.2.2_650¥workspace
X1 ——glE Windows [COT 1Y L TN\B1—F—E& T,

IA—Y-BICEANFHSINTNRNBESIIEEETONENENCH. QT TILTOIYTD DA
U= R ICEEHLTZSV, F2. LESRBEDNKIONSIRES. UMTFDFIRTO =D ZANR=2D7 3 )LD
BEZTO>TIES,

@ LPCXpresso DI 71 )ULX_Za—NH5 Switch Workspace > Other...] ZZIRULDJ v D ULET,

Develop - Welcome page - LPCXpresso
File Edit Navigate Search Project Run Window Help

New Alt+Shift+N > Tidil Hiwits v
0 File... =

pen File ' o [ow
Close Ctrl+W al&l +
Close All Ctrl+Shift+W
Save Ctrl+S
Save As...
Save All Ctrl+Shift+S
Revert
Move...
Rename... F2
Refresh F5
Convert Line Delimiters To >
Print... Cirl+P
Switch Workspace > Other...

7 =ld
Restart
& Import.. [ Switch Workspace > Other...
3 Export... ;a—:g U W 9

Properties Alt+Enter o

1 Welcome [Welcome page]

Exit

T TuTa T proyeT g
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@ T[Brows...l 22w UZET,

1.4 Workspace Launcher X

Select a workspace

LPCXpresso stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

L)1 G el b ¥ Do cuments¥LPCXpresso_8.2.2_650¥workspace g Browse...

» Copy Settings

Browse... &2 wv D

@ ¥AIVEaA—FRD IA—RILT 1 RD(C)>nxpl T #ILIEERL. TFHUWNI 2 LI DR MY
VD )y D UET, fERSNE MHULWI 7Y 1 OEFIZE Tworkspace] I[CEELFET, OB,
HNIFFBRFTADLUTIIZSHN,

Select Workspace Directory X
Select the workspace directory to use.
W 7RIy F ~
@@ OneDrive
adba
v mpc
& Fovn-F
mTAT T
8 FEaAvh
s E9Fv
BTA
b 22Ty
v & TI3141410657S) nxp 2 7 LY &2IR
v nxp
LPCXpresso 8.2.2 650 Select Workspace Directory X
v Select the workspace directory to use.
(%7 LWL\ D 2 )L DIERR
TANS~(E): j
=) W 7207 ~
FLNTAI SO FERRND) Frvtl (: bor;eD”Ve
v mpc
& Fovo-F
mTAT YT
B Ffaxvr
= E0Fv
BYTA
b Za-wh
v & TI314141008B (C)
v nxp
LPCXpresso_8.2.2_650
workspace
J2WIEIC - :
lworkspace| E¥ETAD  Ahs-®  FLLIALY
SFLNTANS-DFERN) Frvtll
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@ COFFETIE. TAIAADPRLEINTUVRND T, T ALY EICERE Nworkspacel EANT DD, U
TOFIET., —ERIDIAIAIZED ) v D URREIC. BE Tworkspacel 22L& D v DL, D=
L&D Tworksoacel [C/8>TUWBZ EEER L. TOKI MY VEBLET,

Select Workspace Directory X

Select the workspace directory to use.

W FAT T A~
& OneDrive
2ba
v WmpC
& AUv0-F
wmTAIYT
2 FEaxvk
= E9Fv
BETA
b Ia-Iyy
v & TI31414100B (G nxp 2 7 LY &R
v nxp |
L Kpresso 822650 \vorkspace T 7 LY EEIR
workspace
v
workspace [C72 > TWNDC E &R
IS —(E): workspace

FLWIANA-OIERL(N) ! oK I A

[OKJ MY V=BT

® workspace 7 # LI N, C¥nxp¥workspacel [CE>TWBDT EEZER L. TOK] MY VEBLE
a—o

Workspace Launcher X
Select a workspace

LPCXpresso stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: |C:¥nxp¥workspace ~ ‘ [ Browse... ;
» Copy Settings [C¥nxp¥workspace] IC82>TU\DC EEHHER
@ OK Cancel

[OKJ hY V=g

MET, D=DAR=D# VI DEELTTTI,
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@QuvYINTOID D1 UR—
RICD=DIAR=R(CHYTINTOI D b+ ViR—FLET,

@ MT®D URL &D. VS-WRC103LV HBR—tXR=IZPOEIL. LED Y >Y7)ILJ0OYy 0~
M'VS-WRC103LV_Sample_LED_xkkxk zip | Cekwk(d/N—I3>) ZFDYO— R ULET,

http://www.vstone.co.jp/top/products/vs-wrc103lv

X YR—R=ITRHELUTNDEDDERHICEDEIN. Ea—+O—/N—0D CD-ROM ZHHHEDI5
&. CD-ROM A®D IC EFEEB_ARM¥Y Y TILTOY D b1 DA IRICE. BTV TILEEF LT
NET,

@ LPCXpresso =& L. BEZA D [Quickstart Panel] @ Start here] & Nmport project(s) |
ZH=EI,

O Quickstart... & -

I Start here

I * Import project(s)

el New project... Import projects

o Build all projects []

Import exisiting projects =89

2 Quick Settings ¥
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http://www.vstone.co.jp/top/products/vs-wrc103lv

@ MURDI A PPOTHRIINDDT. Project archivelzip) ] RD Browsel MY VEBLET,

Import project(s)

Import project(s) B

Select the examples archive file to import.

Projects are contained within archives (.zip) or are unpacked within a directory. Select your
project archive or root directory and press <Next>. On the next page, select those projects you
wish to import, and press <Finish=.

Browse Z#9

Project archives for LPCOpen and 'legacy’ examples are provided.

Project archive (zip)

Archive H | Browse...

Project directory (unpacked)

Root directory| | Browse...

LPCOpen
LPCOpen is the recommended code base for Cortex-M based NXP LPC Microcontrollers.

LPCXpresso includes the LPCOpen packages which can be imported directly by pressing the Browse
button in the Project archive (zip) section, above, and navigating to the Examples/LPCOpen directory.

Alternatively, press the button below to Browse the nxp.com website for latest resources.

Browse LPCOpen resources on nxp.com...

@ < Back Next > Einish Cancel

@ «YR—FFBTOYTH R (CTTRL TVS-WRC103LV_Sample_LED sk thiox | (rerr(d
Y INDON=Y 3 YORENADET)) O ZIP 77+ LEBINT, TFinish ZBLET,

Import project(s) 0 X

Import project(s) B

-
Select the examples archive file to import.

Projects are contained within archives (zip) or are unpacked within a directory. Select your
project archive or root directory and press <Next>. On the next page, select those projects you
wish to import, and press <Finish>.

Project archives for LPCOpen and 'legacyexample .U-yj)lljm y I 9 |\0) ZlP 2 » ’r)IJEE% <

Project archiva (zin)
Archive | C:¥Users¥b¥Downloads¥VS-WRC103LV_Sample LED_20110118_1104.zip | Browse...

Project directory (unpacked)

Root directory Browse...

LPCOpen
LPCOpen is the recommended code base for Cortex-M based NXP LPC Microcontrollers.

LPCXpresso includes the LPCOpen packages which can be imported directly by pressing the Browse
button in the Project archive (zip) section, above, and navigating to the Examples/LPCOpen directory.

Alternatively, press the button below to Browse the nxp.com website for latest resources.

Browse LPCOpen resources on nxp.com...
Finish Z#9
@ < Back Next > Cancel
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® [Finishy 22w 293&E. BEALED MProjectEx] [CT70OY 2 RHhBHNENEd, CcnTJ7OY
I FDFHAHITTTT,

L (I [T LB

&5 Project Explorer ® | & Peripherals+ :f Registers

¥ i VS-WRC103LV_Sample_LED,

# Binaries

Ak ke N u bk 7l

! Includ _
NEBBCENTEEY, = Includes Src 7 A ILAIC

v 2 sre EEBDY—-RIT7AIBBOET,
le| cr_startup_lpc13.c

lg gpio.c

[ ixbus.c

lg main.c

lg vs-wrc103.c
& Debug
= Release
= inc

= lib

QU rIINTJayz O nEILR
RIC. TOTS L% CPUM—RICHRICEBRIDIEEDOEIL FZEFTNET, UTOFIBICHK>T, EILE
Zi7oT<IEZSELN,
@ T[Project Ex] TEILRLEWVWTOY Pk (CCTIE. VS-WRC103LV_Sample_LED) ZEFEIR L.
Project>Build Projecrt 22w 2 LCE)L FZBRIBLE T,

Develop - Welcome page - LPCXpresso

File Edit Navigate Search Project Run Window Help

o | &> ] > Open Project
a8 N N Close Project
[B5Pr. 2 ZPe.. #R. &0 & Build Al Ctrl+B
Build Configurations > _p
¥[% VS-WRC103LV_Sample | gid project B
UE e . : I
#enanes Build Working Set > )
» cludes
EILETD Clean... |
7D S Ig FE%;R cr startup_Ipci3.c Build Automatically I
la gpio.c C/C++ Index ? Ed
(g ixbus.c Properties
[g main.c S a = e
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@ EBILRZEREIBIDEUTDY A POTHNRISINEIDT, TIIDXTHHET,

Building Workspace O X

I-o"-‘ Building all...

D?AIways run in background§

Run in Background Cancel Details >>

@ FTTIBDE F1POTNEL. MTFDXRIICKRRSNET.

2 Console # = U US| L e = A R s B e = |
] CDT Build Console [VS-WRC103LV_Sample_LED]
Building target: VS-WRC103LV_Sample LED.axf ~

Invoking: MCU Linker
A arm-none-eabi-gcc -nostdlib -L"C:/Users/b/Documents/LPCXpresso_8.2.2_650/workspace/VS-WRC103LV_Sample_ LE
Finished building target: V5-WRC103LV_Sample LED.axf

make --no-print-directory post-build
Performing post-build steps
arm-none-eabi-size VS-WRC103LV_Sample LED.axf; arm-none-eabi-size VS-WRC103LV_Sample LED.axf; arm-none-e

text data bss dec hex filename
2629 0 414 3043 be3 VS-WRC103LV Sample LED.axf
text data bss dec hex filename
2629 0 414 3043 be3 VS-WRC103LV_Sample_ LED.axf

17:07:22 Build Finished (took 1s.998ms)

¥ CCTCError "BEEES. (1) DD —=DZAR=A T A IS DESEN EBICTATRNTEEDHDET,
BED—DZAR-=20AWVIDEEETHO>TLIIEEL,
GhLWWD A2 )L DEEIEZEE T, Tworkspacel EANTBEEIIUNTFEBTADLUTLZELY)

X CEFBDY—RZimEULEIC, Error EXRRSNIZHBEOXITEAL 16-7 TS5 —DEBIE] Z2T5E R
<{AN
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6-5 VS-WRC103LV ADTOTSLADESAH

BN TOYI D REEILETDE, D—DAR=RT ALY ¥ VS-WRC103LV_Sample_LED
¥ Debug AIC. N'VS-WRC103LV_Sample_LEDbin] EW\DD 7 JLAYWERSNE T,

CDI7A)%&E CPUM—RICESZTADBE. ERLIETOTS A% CPUMN— RICETSEDICENTER
DT, UFOFIRT, SSRAHETo>TIES0),

UsSBZT —=J/IL&EN L. CPUN— FOETNDERE OFF ICLET,

Ty amPVaBUIEEE. PCEUSBT —JILTERLET,

USBZ#&EmULIZS Ty Y amAVIEELTE OK T,

20 MRER/BDE, PCHCPUMN—RFZUSB XEUREELRU VAR U —=IF /N R EUTERH
LET., (T CPUNR—FZPC ICEIULHRS. @#EIC UIESBENDDDET,)

® oo

1) BUREZEEICTD

3) USB & U= 55@—9» 2) USBT =T ILERELIRAD

® CPUR—EN PC ICER#IcNDE. TCRP DISABLE] EWSEBMOD RS+ TJ&TRRSNET, CPU
M—FZEEHUCS VI VEa—-F ] 28T COBMD RS A INRTSNDCEZERL. &
INDV)y D UTRSATEBEEET,
N—F T8 F347

S AL #0356

VL-RTNZEENELT A

.. DVD-RW 547 (D0 @ GRF DISABLD (E2

[

<
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©® [CRP DISABLEJ ZBE< &, BIC Tfirmwarebinl EWD I 7 1ILA—DA>TNEI DT, DD
71 ILEBIFRLUE T,

= CRP DISABLD (B

| HE REE BTV BROOE y-MD P

Q-0 -0 De= [T ||§ °

| PELAD f g =| £ 1z8h

o

Fir rmvare. bin
FOT4 Data File

32 KB

Clll R

@ D=DIAR=T#)LF ¥ VS-WRC103LV_Sample_LED ¥ Debug MM,
N'VS-WRC103LV_Sample_LED.binJ Z3E—LT. CRP DISABLE. RICR&D{HIFET,

& Debue !IE E
| e REE FTW BROOVE YLD AIH |

Qm-©- 3| Dwe | wm2 |33 X °

| PEVAD) |5 1 25¥morkspace¥VS-WRG103LY Sample_LED¥Debue =] (£ 158h

[

ve—wrc]1 03k _Debug_mem.Id

 IN—
%DKS?FHL

#=SRP DISABLD (E2

y WS-WRGT 030 Sample_LED.axf

| A | FrME REE RTW BRCADE U-LD 7

J Q-7 | oL R ‘ = ?
R I]E:L"-.:"_Eia mple_LED bin

i 1ata File J?HL"A{E} IL# E:x j #g‘ﬁ]
YS=iRG] 02 Samnle | E man % s p

MAaP Pl
91 KB JE-93

fEDITD
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® PC D5 CPUM—RZERDAL, BESRZANDE. ESRAARLTOATSAICHK >TCPUR— RHE)
ELET, LED YT TOTSADESAHNERICT T LTNDE, ZL VY, #&D LED H3RZEIC

RUTLUET,

pea-1-1

‘0Q Q0 ©
.0.0.0.0.0

0.0

n O

US=URECT1AB3LY ©

VUVLVSTONS.CO. P
ote)

(o}

11

00
%d@

:

(0 00
o Ot
0°©

®
®

MET, JOTSLDESAHFIRETTTI,
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6-6 LEDR@EIJOTSAICDNT

YTV LED R 700 S AR BEE LED(. Wait)’2EZEE>T LED ZHIfHLCWET., TN
BN YS D 7 1)U VS-WRC103LV.h R TEZESN. OIS ARTRBIDCENEEET,

LED RIB700 35 A0 main(BEHEURNICHUET, TOTSAZRITIDEE. TTFCD main() BEE
NHEERITEINZT, LED 70T S5 ATIE main(dledc RICHDFET,

1. void main(void)

2 {

3 //HIEBRBDRE (81 Hz & 30.07]
4. const unsigned short MainCycle = 60;

5

6. Init(MainCycle): //CPU D#EAFRTE
T //12C_init(void): //IXBUS #5816

8

o /=T

10: while(1){

11: LED(). //#&D LED RXT
12: Wait(1000);  //1000msec 5D
13 LED(2). //ZLYIDLED RKT
14: Wait(1000);  //1000msec 5D
15: }

16:  }

main BEEDETIC DUV TERBELE T,
O = (D)=
A4~T . SHEBEDFIEARTE
8 XA U)I—=T
while X TENNZERIL—TRICET LIz WEZESER LE T,
O~12 . {79 DB
LED(B8%E Wait () BEEZERIA L C LED ZRAEICRABSIE TNET,

ZREMICDONWTIEI AV Z2APILOSE FZEY Y TILT7OY T FROA VS I 741 )Ulvs-wrc103lv.h]
TEBEICHRELUTNEIDT, ZE5EELIIZE),
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6-7 IS—DIEE

YYINLTAY O EDTOTSLEEE L, LRI DIEBXDOBENSETEIV RIS —NRETDICE
DHDET, Z0HE. MTOFIET, TS5 —DFREUCERZEER L. BELTIES0),

OTOTSACIS—DHorBE. IVY—IUCUTRORIDEE I RIEREHNARTIINFET,
Error DEOEUBEIZ. W DIS—D'HoEDZDENHNRISNZET,

Wait (1000); //1000mseci7F]

E Console 3 . &/ Problems} a Memorﬂ & S&arch} 8g Breakpoints} o Expressions\l 9= Variableﬂ 2o Call Hierarchy\l
C-Build [WS-WRC103LV_Sample_LED] FHE | = R b
arm-none-eabi-gce -D_ USE CMSIS=CMSISvilp30 LPC13xx -DNDEBUG -D_CODE RED -D REDLIB .|
-I"C:/Users/yokoyama S59/Documents/lpcxpresso_3.5/workspace/VS-WRC103LV_Sample LED/inc"

-I"C:/Users/vokovama S59/Documents/lpcxpresso 3.5/workspace/VS-WRCL03LV Sample LED/1ib" -00 -Os
-mword-relocations -g -Wall -c -fmessage-length=0 -fno-builtin -ffunction-sections -mcocpu=cortex-m3 -mthumb

-MMD -MP -MF"src/main.d" -MI"src/main.d" -o"src/main.o" "../src/main.c"

../e2rc/main.c: In function 'main':

wed 3Ee/main.ci22: prrorx: expected ';' before '"LED' |:| Fwu
make: *** [3rc/main.o] Error 1 | ll,l"
Rl P
PC1343 .
S Ly I LIl - L TII SoL'7 I LIl.d O ooy Inall

ILF L I
J'SIcfmain.c: In function 'main':
e fBrefmein. 1 22 arzori—expected™' IS-—0D¥ | 'LED'

make: *#* [src/main.o] Error 1

QIS—DBZERIDLEHICIE. Problems] YT EEIR L. Errors ROWFNHDIS—&ESFT)ILD
Jw2D3ddE IT45LET. IS—EBRNRISINZET,
L0 A BB w5k ks kR R R R R R

int main (wvoid)

/A RIENERADESE (B vz FH: 30,0~
const onsigned short MainCycle = &0;
Init (MainCycle) ; s/cPul f1EAERTE

£

while(l){

20 LED(1): [/ ¥RDLED - — = -
21 Wait (1000) /. 3) IF«BICIS—EHRTEIND
22 5
23 Wait (1000); //1000mseciF &
24 H
25} &
4 2
El Console [[£i Problems &2 @vemory | 47 Search| © Rreaknaints| 1 Fxnrassions | 69 riables} e call Hierarchﬂ ¥ =g
2 errors, 27 Warmmgerd otvers 1 ) Problems E%;R
Description . Resource Path Il
) |
4 © Errors (2items) 2) Errors ADIEBZES IO U YD
| @ expected ;' before 'LED' , “103LV_Sample
@ make: *** [src/main.o] Error 1 VS-WRC103LV_Sample_L...
4 @& Warnings (27 items)
flash.h /BeautoRoverARM_firm _

& 'call_IAP' declared 'static' but never defined
UL |

3

< |

'C1343
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QT CTHIS—IE LEDR2):Daiom Wait(1000 )i T (2=230V) 1 HBRNCEICKDEDTIDT.
ZCEBIEUTBELEILFULET,

int main (wvoid)

J/HRENERAD R E (B 5z #[H:30.0~]

con=t on=igned short MainCycle = &80;
Init (MainCycle); //ceul T EAEEE

FE=1
while (1) {
LED (1) ; SRR LEDS LT
Wait (1000) s Ommeeid )
LED(2} :
Wait (1000) ; Hlmunsecﬁﬁ

DIS—DE<BD, EBCEILFDRTTIREUTORSICRNSNET,

e R EoN |- R N

12int main (void)
134
/RN ERAD 58 (A 5z #E: s0.0~)

const onsigned short MainCycle = &0:

Init (MainCyele) ; / fceuD#EAER E
FA=2

19 while (1) {

20 LED(1) ; /A FRMLEDS T

21 Wait (1000); //1000mseciF)

22 LED(2) ; S LD LED S AT

23 Wait (1000); //1000mseci¥)|

24 }

25}

4

El Console 33 [ Problems} a Memorﬂ & Searchw Sg Breakpointﬂ & Expressions} 4= Variablesw T3 Call Hierarchﬂ
C-Build [VS-WRC103LV_Sample_ LED] @, Bx| ot

arm-none—eabi-objcopy -0 blnary V5- WRClD3LV Sample LED.axf V5-WRCLO3LV Sample LED bla checksum
V3-WRC103LV Sample LED.bin;

Cext data bss dec hex filename
2753 0 490 3243 cab VE-WRCLO03LV_ Sample LED.axf
cext data bss dec hex filename
2753 0 490 3243 cab V5-WRC103LV Sample LED.axf
| Smart Insert ‘ 23:33
201343

MET, IS5 —DEBIEEFTTTI, I7 1 FICKRT UCEICEET DB CTHBMEC > TNDIREME
HOFIDT, ZORICEFRLTCIS—ZBIELT UL D,
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BZTY3aVN-Y, BEBROEAL . - -
Noi dBHZ ! Ea—rO0-/N—-0FTY3Y, DRy ~ESERBOTHEARIFS

http://www.vstone.co.jp/robotshop/

TR, BEDSOMNY hEYSH—EETEONRY FEEBGRZEREVNKROVNEEITET,
ORy FEYY—RRUERIE (RRZIE) Oy bV —-0RRD TIPS (B/IES)

T101-0021 T814-0001
FRETFRBXINBE 1-9-O RBE)IL 4F EBRhRERXEER 2-3-2
TEL : 03-3256-6676 TNC BUAEEE 2F ORI D I PN
FAX : 03-3256-6686 TEL : 092-821-4111
BRI 8 10:30~20:.00 EEISR: 9:30~18:00
TB8% 10:830~19:00 EIRB:E 2 KIEB., FXREFWB

FRFWBEFS, FPREK

BB SEEnEhE

TEL: 06-4808-8701 FAX. 06-4808-8702 E-mail infodesk@vstone.co.jp
SHFE 9.00~1800 (XBHMBIFF)

' ~ > .
D1 ARYHRARA www.vstone.co. jp

T555—0012 ABrmheuie) | IXEHEBS 2-15-28
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